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Unit 1: The Internet 

Question 1: Complete the following: 

From the factors to keep healthy in front of the computer: 

1- …………………………………………….. 

2- ……………………………………………..  

3- ……………………………………………..  

4- ……………………………………………..  

Question 2: What we meant by the following terms: 

1- Cyber Bullying  

2- Contempt  

3- Spam  

4- Happy Slapping 

5- Firewall 

Question 3: Put a tick () after the right phrases and ( ) 

after the wrong ones:  

1- Contempt is adding rude comment in a chat online. (     ) 

2- Phishing is a small malicious program that has the ability to infect computers. (     ) 

3- Avoid continue to sit for a long time mode, and take a break from the correct seating in front 

of the computer. (     ) 

4- Placing the handset between the shoulder and head from the correct seating in front of computer. (     ) 

5- From the correct seating in front of the computer maintain a distance of 45-70cm from the screen. (     ) 

6- While sitting in front of the computer, the head is on one straightness with the back column 

in normal position. (     ) 

7- While sitting in front of the computer, the screen should positioned at the nose level. (     ) 

8- Select the suitable light source and position, while sitting in front of the computer. (     ) 

9- The chair and device level should not be proportional. (     ) 
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10- Leave a distance of about one meter between you and the computer. (     ) 

11- The user's body must move away from the office as wide as possible. (     ) 

12- It is helpful to put a wooden base on the desk to help not bend the neck. (     ) 

13- You should not drink drinks while working on your computer for a long time. (     ) 

14- For non-impact joints, sit properly and move the neck randomly every 20 minutes. (     ) 

15- A happy Slapping in which more than one person is against the victim. (     ) 

Question 4: Complete the following sentences: 

1- ………………………………….. is pretending to be an official body to get personal and 

financial information about others. 

2- …………………………….. are the undesirable messages that come from different places 

with advertisement or news that may contain a virus or harmful material. 

3- Avoid exposing the neck to the ……..………………… and try to avoid sudden changes to 

the atmosphere as the transition from hot air to cool air conditioning. 

4- …………………….…… is the wrong way of expression in chat rooms or messaging or even 

SMS either on the internet or the phone. 

5- It is recommended to close the screen between working hours for ………… minutes every 

hour in front of the device. 

Question 5: Write the scientific term: 

1- They are the undesirable messages that come from different places with advertisement or 

news that may contain a virus or harmful material. 

2- It is pretending to be an official body to get personal and financial information about others. 

3- It is the wrong way of expression in chat rooms or messaging or even SMS either on the 

internet or the phone. 

4- It is the attack of a victim while not paying attention. The partner takes a photo by the 

mobile phone or digital camera on the computer, then publishing the photo. 

5- It is the software or hardware that prevents unlicensed people from surfing certain illegal or 

impolite sites. 

6- It is adding rude comment in a chat online. 
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Question 6: Choose the correct answer between brackets: 

1- The two agreed to photograph their friend without his knowledge in an embarrassing 

situation for him and they posted an online this representing  

(Contempt – Happy Slapping – Phishing) 

2- Your e-mail message will inform you of the profit of the financial amount and request to send 

some data and financial amount administrative expenses to receive the award this represents 

(Contempt – Spam – Phishing) 

3- To prevents unlicensed people from surfing certain illegal or impolite sites we used 

(Firewall  – Spam – Contempt) 

4- If someone talks to you in an impolite or moral way, that is considered 

(Firewall  – Spam – Cyber bullying) 

5- Keep away from the screen with a minimum distance of …………. cm and use a screen with 

good specifications. 

(10 – 30 – 50 – 70) 

6- While sitting in front of the computer screens around your eyes about the device  

every …………. minutes for 10 seconds. 

(10 – 30 – 50 – 70) 
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Unit 2: Scratch program 

Question 1: Mention the Scratch program interface: 

 

 

 

 

 

 

 

 

 

 

 

 

1- ………………………    6- …………………….. 

2- ………………………    7- …………………….. 

3- ………………………    8- …………………….. 

4- ………………………    9- …………………….. 

5- ………………………    10- …………………….. 

Question 2: What are the steps to Change scratch interface 

to Arabic: 

1- ………………………     

2- ………………………  
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Question 3: Put a tick () before the right phrases and ( ) 

before the wrong ones:  

1- Scratch software programming language which is simple and it's a graphical language. (     ) 

2- Scratch software features interface is available in English only. (     ) 

3- Scratch program using which called Blocks (graphical commands for each group). (     ) 

4- Scratch program designed specifically to teach programming in a Visual and logical steps. (  ) 

5- Scratch program used to design games and interactive stories and animated. (     ) 

6- You cannot add sound effects to your own projects. (     ) 

7- Scratch program is not free software we cannot accessed from the Internet. (     ) 

8- You can deal with Scratch program, through the Internet only. (     ) 

9- Scratch program is not fully Supports Arabic language. (     ) 

10- Scratch can run on Linux operating systems only. (     ) 

11- Stage area (it appears as a result of work or project). (     ) 

12- You cannot add different backgrounds to stand. (     ) 

13- Sprites Area (no of sprites used by the project). (     ) 

14- You can't change the size of the platform Stage to full screen. (     ) 

15- You can change where the Sprite on the stage by clicking on it (drag and drop). (     ) 

16- You can locate a sprite left the stage with the value of (x, y) values (-220, 0) where the 

value of Y = 220, X = 0. (     ) 

17- Code blocks is collections of blocks that are install in Scripts Area in a particular order. (    ) 

18- When installing commands, white line down to clarify the place of snapping. (     ) 

19- The Event When Clicked block from Looks Blocks. (     ) 

20- Motion Blocks contains Blocks (commands) used in the movement of sprites or the rotate 

or identify directions on the stage. (     ) 

21- Events contains Blocks used to determine event which is located (or events) on sprites to 

start implementation of the project. (     )  

22- Looks contain Blocks using control patterns and shapes of sprites and colors. (     ) 

23- Not different between Scratch program and other conventional programming languages. (    ) 
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24- Stage area where code sections gather, "installing a set of drawing commands in a specific 

order. (     ) 

25- All Scratch Blocks contains in one group. (     ) 

26- There can be no more than one Sprite object on the stage. (     ) 

27- The Code blocks must not exceed three commands. (     ) 

28- To view the implementation of the project, use Event Blocks in the end of the code. (    ) 

Question 4: Choose the correct answer between brackets: 

1- (Stage – Sprite – Script - Backdrop) area appears as a result of work or project. 

2- Through (Stage – Sprite – Script - Backdrop) area, you can add different backgrounds to 

stage. 

3- (Stage Area – Sprites Area – Script Area - Backdrop) contain sprites used by the project. 

4- (Scripts – Blocks – Motion - Control) is a different sets of Blocks (graphical commands for 

each group), which are used in sections. 

5- (Scripts – Blocks – Motion - Control) is a different set of Blocks. 

6- (Sprite – stage coordinates – Scripts - Code blocks) is the collections of blocks that are 

install in Scripts Area in a particular order (as install game Puzzles). 

7- (Scripts – Blocks – Motion - Control) contains Blocks (commands) used in the movement 

of sprites or the rotate or identify directions on the stage. 

8- The ((go to x:0 y:0  )– ( move 10 steps  )– ( point in direction90)) block moves sprite a 

certain number of steps (10 steps), you can change the value of the steps. 

9- The ((go to x:0 y:0  )– ( move 10 steps  )– ( point in direction90)) block determine sprite 

direction of movement (right-left-top  down). 

10- The ((go to x:0 y:0  )– ( move 10 steps  )– ( point in direction90)) block determine sprite 

transition point place (the horizontal axis and the vertical axis) on the stage and you can change 

its value. 

11- (Scripts – Looks – Motion – When Clicked) block from Event Blocks, to install in the top 

section of code blocks. 
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Question 5: Write the scientific term: 

1- Software features interface is available in English and Arabic, used to design games and 

interactive stories and animated. 

2- Area appears as a result of work or project. 

3- Contain sprites used by the project. 

4- The collections of blocks that are install in Scripts Area in a particular order (as install game 

Puzzles). 

5- Contains Blocks (commands) used in the movement of sprites or the rotate or identify 

directions on the stage. 

6- Contains Blocks used to determine event which is located (or events) on sprites to start 

implementation of the project.  

7- Contain Blocks using control patterns and shapes of sprites and colors. 

Question 6: Choose words from word list to fill in blanks: 

Code block – Sprites Area – Motion – Control – X – Y - Stage 

1- The ………………dimension of the platform Stage the horizontal axis right and left direction. 

2- ……………………………. is the collections of blocks that are install in Scripts Area in a 

particular order (as install game Puzzles). 

3- ……………………area appears as a result of work or project. 

4- You can view information about Sprite, through information symbol in the………………… 

5- You can use the Wait command from……………………..Blocks. 

Question 7: Write the scientific term: 

1- The collections of blocks that are install in Scripts Area in a particular order. 

2- The code sections gather, "installing a set of drawing commands in a specific order. 

3- Is the element to be manipulated and effects added. 

Question 8: Put a tick () before the right phrases and ( ) 

before the wrong ones:  

1- The code sections gather, "installing a set of drawing commands in a specific order in stage 

area. (    ) 

2- The command (Say) exists in Control blocks. (    ) 
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3- You can't control the rotation of the Sprite on the stage. (    ) 

4- You can add different backgrounds to the Stage. (    ) 

5- Through the direction command in the sprite information, you can change sprite direction. (    ) 

6- You can use the Repeat commands from control Blocks. (    ) 

7- When using the Repeat command, you can't control the number of implement the command. (  ) 

8- The Duplicate command used to repeat the code block. (    ) 

9- In the Scratch program, you can't repeat a command more than 5 times. (    ) 

10- To save the project, choose Save Or Save as from Edit menu. (    ) 

Question 9: Choose words from word list to fill in blanks: 

Code block – Menu bar – Motion – Events – Show 

1- You can use the Clicked Event from……………………………..blocks. 

2- The command (Go to) exists in ……………………… blocks. 

3- …………………….……..choice in the sprite information window used to Show or hide sprite 

from the stage. 

4- To view the implementation of the project, use Event Blocks in the top of…………………… . 

5- You can change the interface language of Scratch program to Arabic from symbol in …………. 

Question 10: Choose words from word list to fill in blanks: 

Control toolbar – Open – Undelete – File – Forever – Edit 

1- To open existing file select………………………command from File menu. 

2- You can maximize, minimize sprites on the stage using……………………….. 

3- ……………………....used to undo delete sprite or block. 

4- To change the Stage to small layout choose Small Stage Layout from…………………….menu.  

5- ……………..………….used to repeat block infinite times. 
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Question 11: Rearrange the following steps to Save scratch 

project: 

(………….)Type the file name 

(………….)Select save as 

(………….)From file menu  

(………….)Select the storage place then click Save button. 

Question 12: Write two ways to add a new sprite 

……………………………………………………………………………………………………………….. 

……………………………………………………………………………………………………………….. 

Question 13: Complete the following: 

a) The result of executing the block is……………………… 

b) Replacing the Repeat command with Forever command  

leads to…………………………………………… 

Question 14: Write the function of 

the following: 

Symbol Function 
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Question 15: Correct the underline words: 

1- The (Change Y) block from Event Block and deal with the vertical axis. 

2- The Forever block used to repeat command a number of times. 

3- The command Save As used to save modifications on existing project. 

4- Undo command from Edit menu used to undo deleting the sprite. 

5- When using the Paint Your Own Sprite, you can add sprite from program library. 

Question 16: Match between column "A" and column "B": 

Column "A" Column "B" 

1- Forever block Deal with right and left side. 

2- Change block Used to Repeat block number of times.  

3- Repeat block Used to copy the code blocks 

4- Duplicate Used to create file or new project. 

5- New block Used to repeat command infinite times. 

Question 17: Put a tick () before the right phrases and ( ) 

before the wrong ones:  

1- The Repeat block used to repeat a command number of times. (    ) 

2- The Forever block used to repeat command infinite times. (    ) 

3- The value of wait Block in the Wait ( 1 ) block one second, you can't change it. (    ) 

4- The value of repeat in the Repeat ( 10 ) block is 10 times, you can change it. (    ) 

5- To save project, from Edit menu, choose Save As. (    ) 

6- The Scratch file name extension takes .sb2. (    ) 

7- You can add new sprite from tool bar. (    ) 

8- Sprite library window appears where large groups of sprites are divided into different 

categories. (    ) 

9- To create new file, from File menu, select New. (    ) 

10- You can handle and control sprites on the stage maximize, minimize using the control toolbar 

choices. (    ) 
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11- You can doubling the number of sprite, by choosing Duplicate from the drop-down list. (    ) 

12- You can delete any sprite, by choosing Duplicate from the drop-down list. (    ) 

13- Delete the sprite from the sprite area, it is also deleted from the stage. (    ) 

14- To Undo Delete sprite choose delete. (    ) 

15- A program file (Scratch) that works on any computer with a video program. (    ) 

16- You can't control the number of implement a specific command with scratch program. (    ) 

17- The ( Info ) command used to display information about sprite. (    ) 

18- You can't use Control Blocks to repeat work for order or repetitions of a set of commands 

within the Scripts tab. (    ) 

19- You can choose Maximize and minimize sprite block from drop down list. (    ) 

Question 18: Choose the correct answer between brackets: 

1- You can use …………………………………….to repeat work within the Scripts tab. 

(Looks Blocks – Motion Blocks – Control Blocks) 

2- To Repeat a command a number of times, choose…………….block. 

 (Repeat – Forever – Control) 

3- To Repeat command infinite times, choose…………………block. 

(Repeat – Forever – Control) 

4- To Save the file choose……………from File menu. 

(Cut – Copy – Save as) 

5- The Scratch file name takes…………………extension. 

(Txt – Php – Sb2) 

6- You can doubling the number of sprite, by choosing……………………..from the drop-down list. 

(Delete – Duplicate – Save as) 

7- You can delete sprite, by choosing……………………..from the drop-down list. 

(Delete – Duplicate – Save as) 
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Question 19: Put a tick () before the right phrases and ( ) 

before the wrong ones:  

1- Tabs tool from the important scratch program interface contents. (    ) 

2- Sprite tab deal with Blocks Area "command sets area". (    ) 

3- Sound tab handle playback and recording sounds. (    ) 

4- Costumes/or Backdrop tab dealing with aspects of Sprites/or background stage and 

adjustment. (    ) 

5- When you press tab in both cases Costumes you can use drawing tools and colors available 

and drawing. (    ) 

6- You can't choose a photo as the background of the Stage for your project. (    ) 

7- When you activate the background Stage, Backdrops not appears. 

8- When you press the flip right left selection (edit toolbar) reflected the background image 

horizontally like a mirror. (    ) 

9- When you press the flip down up check the background image reflected vertically. (    ) 

10- Appearances intended Sprites are different forms of the same Sprite. (    ) 

11- You can identify the aspects of the active Sprite when pressing tab Costumes. (    ) 

12- Each Sprite can have more than one form. (    ) 

13- You can switch between the different forms of the sprite by using next costume command. (    ) 

14- When implementing code blocks after you add the bounce command, flops when the sprite 

reaches the edge of the stage but inverted orientation (vertical). (    ) 

Question 20: Write the scientific term: 

1- Is the image covering (or add) the Stage, be behind Sprites to add to the project aesthetic 

form. 

2- When you press the flip right left selection (edit toolbar) reflected the background image 

horizontally like a mirror. 

3- When you press the flip down up check the background image reflected vertically. 

4- Sound tab handle playback and recording sounds. 

5- Block used to stop the project.  
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6- Tab use drawing tools and colors available for modification and graphic in the background of 

the stage. 

7- Tab used to add new appearance to the sprite. 

8- Block used to control the appearance of the sprite. 

Question 21: Put a tick () before the right phrases and ( ) 

before the wrong ones:  

1- To display Pen Blocks click on Pen on the Scripts tab. (    ) 

2- You can't draw any forms using Scratch program. (    ) 

3- You can't add Sound Blocks through Scratch program. (    ) 

4- You can clear any lines and graphics on the stage. (    ) 

5- You can upload a background image from a file Storage medium. (    ) 

6- There are multiple appearance to all sprites. (    ) 

7- Order of blocks or commands not affected to achieve the desired effect. (    ) 

8- You can't control the direction the sprite rotation pattern. (    ) 

Question 22: Write the result of the following code: 

Blocks Function 
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Question 23: Write the function of the following: 

Symbol Function 

 

 

 

 

 

 

 

 

 

 

Question 24: Put a tick () before the right phrases and ( ) 

before the wrong ones:  

1- Color is associated with Change block. (    ) 

2- The current appearance of sprite static can't be changed. (    ) 

3- When you activate the Sprite Costumes tab appears instead of backdrop tab. (    ) 

4- You can repeat a code block so that it does not exceed 30 times. (    ) 

5- The Think for ….Second used to display message in the form of "thought" style and then 

disappear. (    ) 
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Question 25: Write the function of the following: 

Symbol Function 

 

 

 

 

 

 

 

 

 

 

Question 26: Write the result of implement each of the 

following: 

 

Question 27: Write the scientific term: 

1- Option from Backdrops, check the background image is reflected vertically. 

2- Command used to lack of the sprite from the stage and make it backfires when the edge of the 

stage. 

3- Command used to switch between the different forms of the sprite. 

4- Command used to display a message does not disappear. 

5- Command used with it, color and whirl. 
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Question 28: Choose words from word list to fill in blanks: 

Play sound – Degrees – Turn – Pen Down – Clear – Repeat 

1- ……………………….command used for the sprite's rotation angle. 

2- ……………………….command used to clear any lines and graphics on the stage. 

3- To repeat the sprite movement, used Move command with…………………………command. 

4- ………………………..command from Sound Block, used to play sound. 

5- Pen Up command used to Lift the pen moves the sprite without drawing and the 

………………………….……command used to Put the pen sprite movement draw a line. 

Question 29: Complete the following sentences: 

1- From the Pen block commands……………….……… , ………………………. , ………………… 

2- To change the sprite's rotation angle to (45) used………………….………….command.  

Question 30: Write the scientific term: 

1- Blocks used to makes sprite draws lines and painted during his movement. 

2- Blocks used to add and record sound files. 

3- Command used to Lift the pen moves the sprite without drawing. 

4- Command used to repeat drawing a line ( 5 ) times. 

5- Tool contains the Sound tab. 

Question 31: Write the function of the following: 

Symbol Function 
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Question 32: Write down the commands that summarize 

this code blocks: 

 

Question 33: Put a tick () before the right phrases and ( ) 

before the wrong ones:  

1- You can makes sprite draws lines during his movement but you can't control line color. (    ) 

2- Clear command used to clear any lines and graphics on the stage. (    ) 

3- Pen Up command put the pen sprite movement draw a line. (    ) 

4- Scratch program contains a limited number of sound files. (    ) 

5- The ( Set Pen Size to ) can't be increased to (3). (    ) 

Question 34: complete following table with the suitable command: 

A B 

 Add and play sound file. 

 used for the sprite's rotation angle. 

 used to clear any lines and graphics on the stage. 

 Used to assign the pen color. 

 Put the pen sprite movement draw a line 

 


